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Podrška | PeaZip free zip komunalnih pomoć
i tutorial
Kako dobiti podršku
Za teme i pitanja koja nisu obuhvaćena dokumentacije, preferirani način da dobiju podršku koristi bug tracker, kako bi se
racionalno podnese programa bugova, karakteristike i zahtjeve za podršku, dostaviti broj zakrpe i sl
Kada postavljate ili mailing pokušajte da bude više informativne i detaljnije moguće, odnosno odrediti PeaZip verziji i
paketa, domaćin detalji operativni sistem (jezik, 32 ili 64 bita, Windows verziju i servisa razini paketa, Linux distribucija,
verzija, KDE ili Gnome , itd), kompletan način da se repliciraju problem i tako dalje.
Informativni i detaljni poruke ne samo da čini lakše naći rješenja za probleme i dobiti sveobuhvatan odgovor, ali može
postati precios izvor informacija za druge korisnike.
Informacije kompanije, autorskim pravima, TOS i privatnost najave su dostupni na ovoj stranici
Ostali online dokumentacije

• Graška pomoć (.pdf) EN 0.40 – Tema: specifikacije arhiva PEA formatu; Graška komunalnih karakteristike i funkcije.
Hird party dokumentacija je dostupna i na SourceForge domena u Doprineo dokumentaciji direktoriju

• PeaZip Pomoć CHM SJ (.chm) i PDF verzija – Mario Zoppetti
• PeaZip Quickstart Manual (.pdf) – Sydney Lewis-Picard
• PeaZip Software Zahtjevi Specifikacija (.pdf) EN 2.7.1 – Liles Athanasios-Alexandros
• PeaZip Zahtjevi dokument (.pdf) EL 4.7.2 – Sofia Antoniou

PeaZip tutorial
From Options > Localization možete odabrati aplikacije jeziku dvostrukim klikom odgovarajući jezik file – na sadašnjem
nivou razvoja, lokalizacije mijenja jezik GUI glavnog aplikacije.
Ime jezika datoteka se sastoji od dva pismo kod jezika, odnosno “fr” za francuskog u fr.txt; ako je to potrebno za jasnoću,
to će biti i dodao dva pismo pozivni broj zemlje, odnosno “br” za Brazil u pt-br.txt. Imajte na umu da “.txt” proširenje
može biti skriven operativni sistem.
Od Opcije> Jezik kontekst izbornika System možete odabrati jezik Microsoft Windows unosa kontekst meni za PeaZip;
dupli klik (i ovlasti kako bi promjene, ukoliko je pitao operativni sistem) odgovarajući registar datoteku, odnosno “de” za
njemačke.
Brzo tutorial je osnovni korisnika vodič za PeaZip, dodatne informacije mogu se naći u online pomoći datoteku (.pdf), koji
se mogu preuzeti za off-line pomoć, kao i na FAQ stranicama.
PeaZip besplatno zip komunalnih je dostupan i kao instalirati paket i što je prirodno prenosiv aplikacija (i za MS Windows
i Linux), tako da se može koristiti sa prenosivih flash diskova, ili daljinski upravljač, bez potrebe za instalacijom.
Naslov aplikacije prikazuje informacije o trenutnom arhiva, statusnu traku aplikacije daje detaljnije informacije o
odabranom i prikazani sadržaj.
Oblik Organizirati izborniku moguće je prilagoditi ili sakriti bilo koji od primjene barova, odnosno:
– Navigacija bar (Ctrl + Shift + 2) može sakriti (Ctrl + Shift + 1) ili prikazati jednostavan stablo (Ctrl + Shift + 3)
– Status bar (Ctrl + Alt + 1) može sakriti (Ctrl + Alt + 0) proširen za prikaz više informacija (Ctrl + Alt + 2), ili da se
pokaže markere (Ctrl + Alt + 3), povijest (Ctrl + Alt + 4), nedavna arhive (Ctrl + Alt + 5) ili ostavu (Ctrl + Alt + 6).
Organizirati> Aplikacije omogućuje da postavite saradnji sa custom programe i skripte za otvaranje/skeniranje datoteke u
datotečnom sustavu ili unutar arhiva (tj gledatelji file običaj, virus skeneri i sl).
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Na vrhu prozora aplikacije, na alatnoj traci sadrži funkcije / ekstrakcije vezane kompresije.
Imajte na umu ,. o pravu “Extract” gumb, strelica pokazuje izbornik s funkcijama izravno izvući sve sadržaj arhive
najčešćih odredišta, bez daljnje interakcije sa ekstrakcije potvrdu sučelje

• U gornjem području su navedeni najčešći ekstrakcija operacije: ekstrakt svi, omogućavajući da izaberete izlazni direktorij
(Ctrl + E ili F12), ekstrakt svi ovdje (Ctrl + Alt + E), ekstrakt svi desktop (Ctrl + Shift + E) , ekstrakt svi dokumenti (Ctrl + Alt
+ Shift + E), ekstrakt 1..3 ° markiranom staze (ako je definirana), i ekstrakt na default ekstrakcije put (ako je definirana).
Samo prvi, drugi i treći markere su prikazani kao brze ekstrakcije destinacije da ne zatrpavaju meni, ali markera 1..8 su
dostupni sa tastaturom prečica Ctrl + 1..8. Ctrl + 0 ekstrakti na prethodni put.

• U donjem području moguće je postaviti najčešće opcije ekstrakcija: izvući na novu mapu, imenovanja politika (samo za
formate podržane kroz 7z frontend), otvoren izlazni put nakon zadatak dovrši, postaviti default ekstrakcije put.
Adresa bar sadrži navigaciju i pretraživanje kontrole. Odlikuje se brzu navigaciju izbornika (strelica tipku na lijevoj adrese
bara): sličan meni za odabir brzi put je dostupan postaviti izlazni put u vađenje i kompresije interfejsa (vidi ispod).
Na lijevoj strani, navigaciju bar pokazuje staze najčešći datotečni sustav je (desktop, dokumenti, preuzimanja itd) i
korisnički definirane markere; može se prebaci na klasičan stablo direktorija, popis PeaZip funkcija po imenu, ili skriveni
(Organize> Navigacija bar).
U “Otvori s …” podizbornika konteksta izbornik PeaZip je moguće pokrenuti odabrane datoteke i mape (u datotečnom
sustavu kao i unutar arhiva) sa omiljenim programima, skeniranje sa antivirus / antimalware itd; aplikacije mogu se
postaviti u Options> Settings> Otvori s …
U podizborniku “Modify” su istaknuta kopija, premještanje, preimenovanje i stvoriti nove funkcije folder.
U podizborniku “Ostalo” su dostupne druge korisne funkcije, kao što je dodavanje objekata PeaZip je markere, istražite
staze sa upravitelj datoteka sistema, otvorena komandnu liniju u trenutnoj putu itd …
Na dnu aplikacije, ikone katanac omogućuje da postavite lozinku za pregledanje i ekstrakt šifrirane arhive.



PeaZip ima običaj drag and drop modu. PeaZip možete povlačiti iz primjene do sistema bez pisanja podataka sustava temp
direktorij: ovo omogućava softver za završetak operacije, čak i ako nema dovoljno slobodnog prostora u jedinici sistema,
to udvostručuje brzinu ako se podaci koji se spustio na drugi disk ili particiju , a to je suštinski sigurnije jer nema podataka
je napisano izvan odredištu. Drag iz aplikacije na sistem može se koristiti za arhivu ekstrakciju formi i za robusne kopiju
datoteke (na osnovu ROBOCOPY).
PeaZip također prihvaća drag and drop od sistema do primjene, dodati datoteke za arhiviranje (nove ili postojeće) ili
dodati jedan ili više arhive na vađenje liste.



PeaZip po defaultu pokazuje podržao sličica (JPEG, GIF, PNG, TIFF, BMP), bez caching; opcije se može podesiti u
izborniku Organize. PeaZip fajl / arhiva preglednik može se prilagoditi duboko iz “Organizirati” izbornika, i može
Pojedini detalji, liste ili velike ikone.



PeaZip unosa u kontekstu izbornika sistema: stavke izbornika i datoteke udruženje u Windows postavljaju setup paketa,
može se koristiti bilo koje vrijeme je potrebno bez potrebe da prvo UNISTALL aplikacije.
Polazeći od Microsoft Windows 7 stavke izbornika su poredani u kaskadama podmeni sa ikonama, jer W7 uvodi novu
metodu registar stvoriti kaskadno izbornika koji se sada preporučuje preko metode COM.
Tokom instalacije sve stavke u kontekst meni može se preskočiti i može se stvoriti u podizborniku SendTo ako preferira.
U SendTo unosi se link datoteke stvorene u SendTo sistemu folder koji, pod pretpostavkom C što su disk sistema, nalazi
se u C:\Documents and Settings\(korisničko ime)\SendTo (Windows XP) ili C:\Users\(korisničko
ime)\AppData\roaming\Microsoft\Windows\SendTo (Vista/7), moguće je jednostavno kopirati željenu SendTo veze od
jednog korisnika na drugog.



Arhiviranje / konverzije sučelje: rightclick na listi datoteka pokazati kontekst meni dodatno uređivanje lit fajlova i foldera
koji se arhiviraju, i druge opcije. Katanac ikona pokazuje da li lozinke i omogućuje da postavite / promjenu / izvadite ga.
U arhiviranje sučelje je dodao: “Pretvori postojeće arhive” opciju, izvući postojeće arhive prije kompresije faza – tj
pretvoriti RAR datoteke u 7Z ili ZIP formatu.
Ova opcija, koristi sa “Dodaj svaki objekat u posebnu arhivu” omogućena opciju, vrši masovna konverzija navedene
arhive željeni format; inače, sa onemogućen opciju, arhiva konverzije treba da konsolidaciju unos podataka u jednom
arhivu, poboljšanje kompresije efikasnost jer omogućava rekompresije originalnih podataka iz nekomprimovani obliku.
Napredna format kompresije specifične karakteristike su dostupne u “Advanced” tab, “Console” i “Raspored” karticu
može se koristiti za fino podešavanje definiciji zadatak ili za spremanje i zakazati zadatak kao skriptu



Ekstrakcija sučelje: rightclick na listi datoteka pokazati kontekst meni dodatno uređivanje lit fajlova i foldera koji se
arhiviraju, i druge opcije.
Uređivati liste ekstrakcija omogućava da se djelomično izvuče podatke iz arhive, ekstrakt sve, ili da se izvuče iz više
arhive odjednom.
Katanac ikona pokazuje da li lozinke i omogućuje da postavite/promjenu/izvadite ga.
Moguće je postaviti politike u slučaju sukoba s postojećim datotekama: preskočite (default), prepisati, preimenovati
postojeće datoteke, preimenovati odvojivom datoteke, ili pitati interaktivno (u procesu backend ‘konzole).
U obavljanju djelomičan vađenje sadržaja iz arhiva, to je istaknuta link da biste se prebacili na punu arhivu ekstrakcije, na
vrhu liste objekata navedene za ekstrakciju.
Napredne ekstrakcije značajke formata specifične su dostupne u “Advanced” tab, “Console” i “Raspored” karticu može se
koristiti za fino podešavanje definiciji zadatak ili za spremanje i zakazati zadatak kao skriptu.



Od Console kartici, istaknuta u arhiviranje / konverzije i ekstrakcija UI, moguće je da se pretvori zadatak definirane u GUI
sučelje u skladu skripta komandu koja se mogu uređivati (nezavisno od definicije zadatak u GUI frontend), klikom na
“Kliknite na uvoz … “etiketu.
Ako definicija zadatak je promijenilo u GUI istom etiketa može se koristiti za osvježavanje definiciji zadatak.
U ekstrakcije interfejs “Kliknite na uvoz …” etiketu može rightclicked za modificiranje komandne linije za rad na svim,
prikazuje se ili odabrane objekte, ako je parcijalni vađenje sadržaja je podržana za trenutni tip arhive (7z, ARC, RAR, Tar,
zip …).
Skripta definicija zadatka mogu se uređivati, pokrenuta za testiranje, ili spremiti kao tekstualnu datoteku za buduću
upotrebu, odnosno studija, skriptiranje, analiza itd
Po defaultu, PeaZip traži da spasi skriptu u svom “sačuvani skripte” folder (jedinstven za svakog korisnika) koji se mogu
otvoriti iz Tools u glavnom izborniku.



Raspored kartici, istaknuta u arhiviranje/konverzije i ekstrakcija UI samo na Vista i novije sisteme, ima za cilj da pomogne
stvaranju, u jednom prolazu, raspored za pokretanje skripte (backup, vraćanje, itd) proizvedena iz zadatka definirano u
GUI sučelje.
Raspored se prepoznaje se po jedan jedinstven, uređivati ime, koji se koristi i kao naziv datoteke za spasio zakazana
skriptu.
“Upravljanje sačuvanim zakazana skripte” otvara PeaZip je zakazana spremljene skripte folder tako skripta datoteke mogu
se uređivati da promijenite definiciju zadatak (šta zadatak da), kopirati, briše itd
“Task Scheduler, upravljanje zadacima sačuvati u PeaZip grani” otvara sistema Task Scheduler, PeaZip zadataka se
prikupljaju u PeaZip potfascikli zakazanih zadataka biblioteke (drvo na lijevoj Task Scheduler prozor).
Od sistem Task Scheduler je moguće upravljati PeaZip zakazane zadatke, odnosno za fino podešavanje raspored (Kada
zadatak Run), ili brisanje zastarjele zadataka.
Raspored padajući izbornik omogućuje da postavite raspored na satu, dnevno, tjedno, ili mjesečne osnovice, ili jednom, sa
početkom u određeno vrijeme početka.
Opcionalno, može se pruža različite korisnika / lozinku za pokretanje zadatka.



PeaZip za Linux i PeaZip za BSD su desktop neutralni komunalnih i dok god su instalirani potrebni biblioteka (GTK2 ili
Qt, i IA32-libs na 64 bit sisteme) može se koristiti na KDE, Gnome ili drugih desktop okruženja.
PeaZip softver je razvijen uz Lazarus / Freepascal, koji podržava širi spektar sistema i widgetsets (uključujući i BSD i
Apple Mac OSX), ako ste zainteresirani za prenošenje ček zahtjev za izvore na download stranici.
PeaZip je neutralan desktop programa, a to se distribuira na domeni aplikacije kao generički Linux pakete nije usmjerena
na određenu distribucije: to je značilo da se radi na što je više moguće distribucijama/verzije, i na više desktop okruženja.
Preporučuje se da provjerite svoju distribuciju je spremište pronaći ako određeni paket postavljanja vašim potrebama, u
najboljem slučaju je Ben objavio distribuciju održavaoca.
Imajte na umu da IA32-libs su potrebne za pokretanje PeaZip i bilo 32-bitni binarni na 64 bitni Linux/BSD sistemima.



PeaZip je potpuno modularan softver zbog svoje frontend/backend arhitekture, tako da bilo backend binarni može
samostalno zamijeniti sa alternativnim verzijama (tj 64 bitne verzije) dok je podržao istu sintaksu.
Ovaj dizajn omogućuje također da lako izvoziti zadatke definirane u GUI, kao naredbu linije, koja će se koristiti za buduće
iteracija istog zadatka, odnosno za učenje svrhu, ili za fino podešavanje operacije beyiond obim i granice grafičko sučelje.





PeaZip besplatni zip komunalnih može biti integrirana u kontekstu izbornika KDE i Gnome; sve resurse da ručno
integrirati prijenosni verzija programa, ili poboljšati integraciju instalirati verziju a, mogu se naći u
FreeDesktop_integration folder u putu programa.
Instrukcije odnosi se na generički Linux sistema, ali se mogu primijeniti na istom menadžeri desktop pod BSD sistema.
Imajte na umu da različite distribucije i različitih okusa BSD može se razlikovati u nekim stazama default sistema.
Nautilus: ručno kopirati ‘Arhiviranje’ folder, koji je sadržan u ‘Nautilus-skripte’, na svoj profil korisnika folder ‘.gnome2 /
nautilus-scripts'; taj folder je skriveno, tako da možete ili pronaći klonutost ‘View> Prikaži skrivene datoteke u Nautilus,
ili klikom na “Skripte> Open skripte folder u kontekstu izbornika GNOME.
Konqueror (KDE 3.x) uslugu meni (.desktop datoteke): kopirati .desktop datoteke iz “KDE3-Konqueror” folder u (KDE
direktoriju)/Share/apps/Konqueror/ servicemenus. Imajte na umu da KDE direktoriju mogu varirati od distribucije do
distribucije (ili čak mogu biti prilagođeni od strane korisnika na KDE instalacije); /Opt/KDE3 je obično zajednički mjesto
za instaliranje KDE i koristi se, u primjeru, u Suse i openSUSE. The (KDE direktoriju) je navedeno u $ KDEDIR u
varijable okoline i može se nadjačavaju $ KDEDIRS.
Ova integracija se automatski obavlja instalater.
Dolphin (KDE 4.x) servis izbornik: kopiranje .desktop datoteke iz “kde4-Dolphin”
u/usr/share/kde4/usluge/ServiceMenus/. Imajte na umu da neke distribucije mogu koristiti različite staze. Ova integracija
se automatski obavlja instalater.
Ako je Qt verzija ne počne na nekim sistemima, kao vizualni stilovi neki sistem može izazvati rekurzivnih bojenje
pogreške, možete popraviti problem počevši ga u konzoli (ili skripte) su: PeaZip -Style = cleanlooks


